Telosys 1.1.0 Starter Kit

How to create a neWwelosys project
In
Eclipse 3.x for Java EE
and
how to use thdelosys Toolsplugin
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Step 1 — Setup the Eclipse environment

1.1 — Install the “TelosysTools plug-in” in Eclipse

Stop Eclipse

Downloadtelosys-tools-plugin_X.X.X.zipfrom the Telosys web site
http://telosys.ow2.org~> Download

Unzip file telosys-tools-plugin_X.X.X.zipin the Eclipse « plugins » directory
Restart Eclipse

Check the “Plugin details” : “Help®> “About Eclipse”> “Plug-in details”
The Telosys Tools plug-in must be in the list.

1.2 — Select the JRE

Window = Preferences ...

& Preferences |__|@
| type fiter text | Installed JREs &

& General & Add, remove or edit JRE definitions.

B Ant By default, the checked JRE is added to the build path of newly created Java projects.

i Data Installed JREs:

- Help I |

- InstalfUpdate [ Mame Location Type add..,

#- Internet B jret CitProgram FilestJavaljred  Standard WM

=) Java =

i % Appearance

{ % Buid Path

i [ Code Style B

¢ [# Compiler [

. [# Debug |

- JUnik

: ‘v Properties Files Ei
[+ Plug-in Developrent

- Run/Debug ¥
£ J *

(7 K ] [ Cancel

Choose dull Java SDK, because a Java compilsrequired to compile the JSP.

Telosys supports all the Java versions from Jada 1.
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If necessary, add a JRE as follow :

Click the « Add » button and « Browse » to seleealed JRE home directory

JRE tvpe: |Stanu:|ar|:| WM L |
JRE narne: | Javabnza |
JRE home directory: | Dutlavallavasiza | E_Ernwse... |

Default YM Arguments: | |

IRE syskem libraries:

E DY Javal Javasnzstjrellibhrt. jar [ Add External JARs. .. l
E DY Javal Javasnzatjrellibljsse. jar

E DY Javal Javasozdjrellibhjce.jar

fm i JavalJavasozdjrellibhcharsets. jar

El i Javal Javasozstjretlibhextdnsns. jar

E‘ i Javal Javasnzdjretlibhextilocaledata. jar

& Di\Java)JavaS0zsrelib\extisunice_pravider.jar
& Di\Java)JavaS0zsjrelib\extisunpkes1 . jar

BB B

('E) [ K, ] [ Cancel l

Select the new JRE added ( other unused JRE caamimyved )

& Preferences |:|E]

| type Filter text | Installed JREs R

getneral A &dd, remove or edit JRE definitions,
i

By default, the checked JRE is added to the build path of newly created Java projects.
Data Installed JREs:
Help

Installlipdate Mame Location Type add...
Internet = JavaS02s [:YJaval Javasiza Standard Y
Java
Appearance
Build Path
Code Style
Compiler

Editar

LN R e R e

LN e R e R R

Installed JREs

Execution Ers
A Imik —

< | »

@ O l l Cancel

Click the « OK » button
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1.3 — Define the Tomcat server

This guide is based on Tomcat because it's onkeofrtost used servlet container.

But Telosys works fine with any standard servlettamer compliant with servlet 2.4 and JSP
1.2 (and more).

Any Tomcat version can be used since Tomcat 4.

Select Window> Preferences ...

& Preferences

| type Filter text Installed Server Runtime Environments

Gaeneral ”

Ank
Diata Installed server runtimes:

add, remove, or edit installed server runkime definitions,

Help Marne Type add. .,
InstallfUpdate

Internet
Java
Plug-in Development
Run/Debug
SErvEr Search...
Audio
Installed Runkirme
Launching
Tearm

Walidation
Web and ML 3 L1 | >
o =
<

(0] ] ] ] ] ] ] ] - ]

0 LER N S Pt

@ [ (0’3 ] [ Cancel

If necessary, click the « Add » button to defineeav server.
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& New Server Runtime @

New Server Runtime
Define a new installed server runkime environment

Runtimes are used at build time to caompile projects,

Select the type of runtime that vou want to define:
Dor't see your server listed? Click here
== Apache ~
E Apache Tomcak w3.2
a Apache Tomcak 4.0
E Apache Tomcak w4.1
E Apache Tomcak +5.0 1
E Apache Tomcat w5.5

[ BE& Systems
.7 Ommis

11E4

Wigw By | Yendaor L
Description: Apache Tomcat +5,0 supporks J2EE 1.2, 1.3, and 1.4 ‘Web modules,

2) < Back, [ Mexk = ] [ Einish ] [ Cancel

Select « Next » button and:

- choose the Tomcat installation directory
- select the JRE

& New Server Runtime @

Tomcat Server

Specify the installation directory

Mame:

| Apache Tomcat +5.0 |

Tomcat installation directory:

|D:'|,TDmu:at'l,Tu:umu:at-5.D.28 |[ Browse, ., ]
JRE:

v| [lnstalled JREs... ]

':':’:' Mexk = Einish ] [ Cancel

Select « Finish » button
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Step 2 — Create a standard Java Dynamic Web Project

2.1 — Create the Dynamic Web Project

File > New (Alt+Shift+N)-> Project ...
Web-> Dynamic Web Project ( with Tomcat )

& New Project x|
Select a wizard
Create a Dynamic VWeb project

Wizards:
I type filter text

F-2 Eclipse Modeling Framework :l
H-2- EJB
-l J2EE
B[ Java
E-2 Plug-in Development
B Web
S
.. 537 Static Web Project
B2 Examples -

&

@ = Back I Next > I Finish Cancel |

& New Dynamic Web Project

Dynamic Web Project

Create a standalone Dynamic Web project or add it to a new or existing Enterprise | 9
Application, -—

Project name: | TelosysToolsExample |

Project conkents:
Use default

£ |= \TelosysToolswlsTelosvsTools\ TelosysTonlsExample | Browise. .

Targek Runkirne

| fipache Tomcat v5.0 V| lNgw... l

Configurations

I <custom > |

Hink: Get skarted quickly by selecting one of the pre-defined project confiqurations.

EAR Membership

Add project to an EAR

@ [ = Back ” Mext = ” Finish _H Cancel
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Select dNext » button

& New Dynamic Web Project E]

Project Facets 3
Adds support For writing applications using Jawa programming language. \?
Configurations: | <cuskom = w | ’ Save ] Delete
Project Facet Version
[#]/59 Cvnamic Web Madule 24
& 50..
[] = webDoclet {xDaclet) 1.2.3..
<< Show Runtimes
':'E:' [ < Back H Mext = ] [ Einish l [ Cancel

Select «Next » button

&= New Dynamic Web Project @

web Module

Configure web module settings.

Conkext Rook:

| TelosysToolsExample

Canktent Directary:

| ‘iehConkent

Java Saurce Directory:

| SFC

Mext = Finish

J|

Cancel

Select «inish » button
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2.2 — Test the new projet with Tomcat

Create a ¢est.jsp » file in WebContent directory and try to run it.

Right click onwebContent directory-> New —> JSP

& New JavaServer Page @

JavaServer Page
Create a new Javaderver Page. Q

Enter or select the parent folder;

| TelosysToalsExample/WebConkent

o
I=F Servers
E TelosysToalsEx:
(= <} TelosysToolsExample
[= .settings
= build
= src
[= WwebContent

File name: | kest.jsp

'\?J [ Mext = H Eirish H Zancel

Select « Finish » button
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Insert “hello” in the <body> tag of the JSP file

=8

<% page language="java™ contentType="text/html; charset=I30-
pageEncoding="I30-8359-1"%>
<IDOCTYPE htwl PUBLIC "-//W3C//DTD HTML 4.01 Transitionsl//EN'
<htrml=>
<head:>
<meta http-egquiv="Content-Type™ content="text/htwl; charset=I:
<titlerInsert title here</titlex
</ head:>
<body=>
hellao
< hodys
</ hrml>

Right click on the project directorp Run As—> Run on Server
& Run On Server E‘
Define a New Server

Chonse the bvpe of server ko create g

How do wou want bo select the server?

(%) Manually define a new server

Setver's host name: | localhost w

Select the server bvpe:
Don't see vour server lisked? Click here
= Apache Al

=

5 Tomcat %32 Server
B Tomecat 4.0 Server
Tomcat w41 Server

Tomcat %50 Server

[EHE] R

i Tomcat »5.5 Server

[#-[= BEA Systems

- (= I6M =
[#-[# 1Boss

| [ (= Objectieb st

Wigw By i\-‘endor el
Descripkion: Publishes and runs JZEE Web projects and server configurations to a local Tomcat server,

Server punkime: i.ﬂ.pache Tomcat 5.0 » | ljlnstalled Runkimes. .. |

[15et server as project defaulk (do not ask again)

13 < Back: Mext = H_ Einish ][ Cancel ]

Select « Next » button
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Make sure that your project is in the « Configupediects » part

& Run On Server @

Add and Remove Projects =
Maodify the projects that are configured on the server
—J
Maove projects ta the right to configure them on the server
Available projects: onfigured projects:
I_=:-; TelosysToolsExample
fdd =
< Remove
add Al =
<< Remove all
3] [ < Back ] - Mext:= | [ Eirish ] [ Cancel

Select « Finish » button

Verify the good execution of your JSP file

. Tnsert title here X

test,jsp

= (] Qéh |http:,l',l'l-:ucalhu:ust:BEIBIZI,I'TEIDSysTnnIsExampIe,l'test.jsp v| =

hello

At this step you just have a standard Java Dyn&@b Project.

This project works fine, it is ready to become $o%gs project...
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Step 3 — Transform the project into a Telosys proje

3.1 — Import the Telosys Starter Kit in the project

Downloadtelosys-x.x.x_starterkit.zipfrom the Telosys web site
http://telosys.ow2.org~> Download

Do not unzip it.

Stop the Tomcat server if it’s still running.

Import the starter kit ( the “zip” file ) in the gject :
Right click on your projec® File > Import-> Import ...

Select GeneraP Archive File

& Import x|
Select \
Import resources from an archive file into an existing project. IE - 5 i

Select an import source:

Itype filker text

El-= General

RLeY - chive File
g Breakpoints

------ = Existing Projects into Workspace

-7, File System

- El preferences
F-= CVS

H-= EIB

B-= J2EE

-2 Plug-in Development
= Team

= Web

F-= Web services

7 = Back I Next = I Fifish Cancel

Select «\ext » button

Telosys Starter Kit - v 1.1.0 ( September 2010)

ct

Page 12



Browse the file system to select the tidosys-x.x.x-starterkit.zip ...

Archive file

Import the contents of an archive File in zip or tar Format From the local file syskem. I

=4

From archive File: |d:'l,prDFiles'l,cdesm|:qu'l,My Documents| Téléchargementsitelosys-1, v| [ Browse, .. ]

= [E?ﬁ =] telosys-toals.cfg
[V] = sre
[#] (= TelosysTools
[v] = WebContent

[Filter Iﬂ;.-'pes...] [ Select all ] [ Deselect all

Into Folder: | TelosysToolsExample | [ Browse, .,

|:| Cverwrite existing resources withouk warning

':?:' Finish ] [ Cancel

Click the «Finish » button

Overwriteweb.xml in folderxxx/WebContent/WEB-INF ?
- Answer “Yes”
Refresh the project ( F5)

After the import there’s
» few Java classes in “src”
» few web resources in “WebContent” ( .jsp, .js, ... )
o 2jar files in WEB-INF/lib :
o0 derbyclient.jar : the JDBC driver for tests withzerby” database
o0 telosys-x.x.x.jar : the Telosys framework

That's all !

Your project is now a “Telosys project”.
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3.2 — Try to run the project

Right click on your projec® Run As—> Run on server

& Run On Server x|
Define a New Server
Choose the type of server to create

How do you want to select the server?

*' Choose an existing server
" Manually define a new server
Select the server that you want to use:

= = localhost
".f] Tomcat v5.0 Server @ localhost

View Ey:IHust name ¥

Description: Apache Tomcat v5.0 supports J2EE 1.2, 1.3, and 1.4 Web modules.

[~ Set server as project default (do not ask again)

@ < Back | Next > | Finish I Cancel |

The welcome page appears in the Eclipse web brawser

% Welcome &2

O | http://localhost:8080/test110bis/

Telosys test page

Test servers presence

Test screenmap server without screen name
Test actions server without action name
Test services server with nonexistent service

Test servers with real resources

Test screenmap without context ( 'Test1"

Test screenmap with context on the server side ( 'Test2'
Test screenmap with service on the server side ( 'Test3' )
Test services server with an existing RPC service ('ping' )

/dao/Author/loadlist
/dao/Author/loadlist?where=id < 5
/dao/Author/load?id=1

Telosys Starter Kit - v 1.1.0 ( September 2010)
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Check there’s no error in the console.

Problems| Tasks| Proper‘ties| Ser\rers| Snippets m\

|G RB| % B~ =0

Tomcat v5.0 Server _ localhost [Apache Tomcat] D:\TelosysToulouse\java\bin\javaw.exe (Apr 3, 2007 8:40:49 PM)

info
info
info
info
info
info
info
info
info
info
info
info
info

[org.
env.
[env.
[env.
env.
[env.
[env.
env.
[env
[env.
env.
[env.
[org.

objectweb.telosys.auth.AuthFilter]
InitServlet]
InitServlet]
InitServlet]
InitServliet]
InitServlet]
InitServlet]
InitServlet]
MainFactory]
MainFactory]
MainFactory]
InitServlet]

init()

Login URL = null

4]

= InitServlet : init ()

= Server Info : Apache Tomcat/5.0.28

= Version - 2.4

= Context Name : Application Hame
= Real Path : D:\Telosy=sToulouse'\workspace' .metadata\.plugins\org.ecl

=== Main Factory Creation
MainFactory creation
screen registry creation
gervice registry creation
=== Telosys Initialization

objectweb.telosys.common.Telosys] INIT

Telosys.init (extFactory,

config)

J

Stop Tomcat Server

Telosys Starter Kit - v 1.1.0 ( September 2010)
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3.3 — Configure the project

The Telosys Tools plugin can be used to custonhigd elosys project’s properties.

Let's have a look at these properties ...
Select your project + right click® “Properties”™> Telosys

The “General’ tab :

& Properties for Telosys110StarterKit ;Iglil

|type filter text Telosys oo w
-~ Resource -
. BeanInfo Path General | Packages| Classes mmes| Advanced | About plugin |
- Builders Project name : |TE!05‘-’1 10Starterkit

- J2EE Module Dependenc

. Java Buid Path Project location : | D:\workspaces\whs33-starterkit\Telosys1 105tarterkit
& Java Code Style Project config file : | D:/workspaces/wks3 3-starterkit/Telosys1105tarterkit/telosys-tools.cfg
&-Java Co_mpller Source folder : | src
- Java Editor

- Javadoc Location Templates folder : | TelosysTools/templates

~J5P Fragment Repositories folder : | TelosysTools/repos

- Profile Compliance and v

 Project Facets Telosys properties file : | WebContent/\WEB-INF/conf/telosys.properties

- Project References

- Refactoring History

- Run/Debug Settings
- Server

- Targeted Runtimes

- Task Tags

- Validation

- \Web Content Settings
- \Web Project Settings

- XDoclet
«| | _’I Restore Defauitsl Apply |

ok | concel |

“Source folder” : the folder containing the Javarses
“Templates folder” : the folder containing the Velty templates used for code generation

“Repositories folder” : the folder containing thepositories ( the models used as input for code
generation )

“Telosys properties file” : the main Telosys comniigtion file

-> At this step, you don’t have to change anything
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The “Packagestab :

& properties for Telosys110Starterkit I IDIil

|type fiter text Telosys w7 &
- Resource
BeanInfo Path General Packages |dm€5 names| Advanced | About plugin |
- Buiders VO Bean package I org.demo.vo.bean
J2EE Module Dependenc r :
- Java Buid Path VO List package |0rg. lemo.vo.list
& Java Code Style DAC package I org.demo.vo.dao
Liiddild Co_mpi}er XML mapper package | org.demo.vo.xml
- Java Editor
--Javadoc Location Screen Data package I org.demo.screen
JSP Fragment Screen Manager package | org.demo.screen
- Profie Compliance and V ) . p
Project Facets Screen Triggers package | org.demo.screen

- Project References
Refactoring History

--Run/Debug Settings
Server

- Targeted Runtimes
Task Tags
Validation

--Web Content Settings
Web Project Settings

Bl XDoclet
4 | | _’I Restore Defaults | Apply |

@ ok | cancel |

This tab allows to set the packages for each typtasses.
They must be defined according with the packaggarozation of your project.

The “Classes namédab :

& properties for Telosys110Starterkit _ o] x|

|type filter text Telosys ¥ >
- Resource :
BeanInfo Path Generaﬂ| Packages Classes names |Advanced | About plugin |
- Builders VOList class I
J2EE Module Dependenc B}
tax : Prefix${BEANNAME}Suffix ( default : '${BEANNAME}List'
--Java Buid Path sk Uit EI SR (et S BERNAMES (o)
- Java Code Style DAO class I
&-Java Compiler Syntax : PrefixS{BEANNAME}Suffix ( default : '${BEANNAME}DAQ' )
&-Java Editor XML mapper class |

Javadoc Location
--JSP Fragment
Profile Compliance and V
- Project Facets
Project References
- Refactoring History
--Run/Debug Settings
- Server
- Targeted Runtimes
Task Tags
Te?osys
Validation
--Web Content Settings
- \Web Project Settings

Bl XDoclet
- | | _’I Restore Defaults | Apply |

(7) OK I Cancel |

Syntax : Preﬁxﬂ;{BEANNAME}SuﬂTx ( default : '${BEANNAME}Xml' )

It's possible to define classes naming conventrare, by adding a prefix or a suffix at the
“entity bean name”.

- For the moment, do not change anything in theggitg properties.
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3.4 — Install the Telosys documentation

Download the documentation files from the Telosgbwite
» telosys-x.x.x_javadoc.zip( Java classes documentation )

» telosys-x.x.x_jsdoc.zig Javascript functions and classes documentation )

* telosys-x.x.x_taglibdoc.zig TagLib documentation )
http://telosys.ow2.org/> Download

Unzip these files in the folder of your choice
You obtain one folder for each file :
» javadoc
* jsdoc
» taglibdoc
Open the “index.html” of each folder to browse tleeumentation

Attach the Javadoc to the “telosys-x.x.x.jar" file

Right-click on your project, selecPtoperties’ - “Java Build Path’
In the “Libraries” tab :
* open ‘Web App Libraries”
* open ‘telosys-x.x.x.jar
» select Javadoc locatiori
o click “Edit”
0 selecttelosys-x.x.x_javadoc.zip as “External file”
0 set javadoc’ as “Path within archive”

i _ o] x|
type fiter text Java Build Path st
- Resource = =
. Beanlnfo Path [ source| = Projects = Libraries l% Order and Export |
- Buiders JARs and class folders on the buid path:

J2EE Module Depend

I =) Apache Tomcat v5.0 [Apache Tomcat v5.0]
- Java Buid Path -

i B EAR Libraries

&l Java Code Style &) JRE System Library [Java 5.0-15]
&1 Java Compier =4 Web App Libraries e 5
4 Java Edtor -£l Access rules: No rules defined

- Javadoc Location -&% Native lbrary location: (Mone) AddLibrary .,

.~ ISP Fragment - derbyclent.jar - test110b/WebContent/WEB-INF/ib

- Profile Complance an =07 telosys-1.1.0.jar - test1 10b/WebContent/WEB-INF/ib
- Project Facets

~ Project References
- Run/Debug Settings

fidd Class Folder |

+[E] Source attachment: (None)
7] Javadoc location: file:/D:/Tmpy/telosys-doc/telosys-1.1.

g Native Tbrary location: (None) Remove

Edit...

- Server £ Access rules: (No restrictions)

Targeted Runtimes IMicrate JARLFlE,,
Task Tags , P =

e x

~ Valdation

" Javadoc URL (e.g. 'hitp://www.sample-url.org/doc/' or file:/c:/myworkspace/myproject/doc’)

- Web Contet
. Web Projec,  Javadociozation path; | Eraise
:ﬁ ¥Dnclet yaldare,,
(& Javadoc in archive
A7) 0 Externalfie Workspace file il

Archive path: | D:\Tmp'telosys-dochtelosys-1.1.0_javadoc.zip Browse...

Path within archive: | javadoc Browse...

Validate...

b L

cnce
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Step 4 — Setup the database and the repository

4.1 — Install the “Bookstore” DERBY database for te sts

A lightweight database is provided on the Telosgb wite for demonstrations, it is very easy
to setup ...

DownloadbookstoreX.X_derby X.X.X.zipfrom the Telosys web site
http://telosys.ow2.org~~> Download

Unzip the file in a folder ( this folder will beeélDERBY_HOME folder )

Start DERBY by running the command file
DERBY_HOME/start.bat
or
DERBY_HOME/bin/startNetworkServer.bat (Windows)
DERBY_HOME/bin/startNetworkServer (shell Unix/ILix)

The database engine is running in a command windoa s now ready to accept connections.

To stop the Derby database : just close this window
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4.2 — Connect to the database

Edit the ‘databases.dbcfyfile with a “text editor”

This is an XML file.
Just uncomment the DERBY entry as follow :

<db id = "o"
natne = "DEREY - TelosysBookStore DE™
driver = "org.apache.derby. jdbe. ClientDriver™
url = "jdbe:derby://localhost: 1527 /hookstore”
izolationLewvel = "
poolSize = "3 o

<property namwe="user” wvalue="root" />

<property name="passwvord” value="admin" />

<metadata catalog="" schema="ROOT" table-hame-pattern=":" table-types="TALELE VIEW " /=
_<fd.b>|

The “id” of the database will be “0”, a connectipool will be created, and the JDBC driver is
in the derby “.jar” file imported with the startkit:

Save and closéatabases.dbcfdile.

Now, open thelatabases.dbcfdile with the ‘Dbconfig editor”

= : M S P S
: [~ %0 B i@y i
'EEﬂDhEDnﬁgEdtDr
|i= Copy Chrl+C Texk Editor
]
; % :E;VEGT E | |=| Swstem Editar
= TelosysToolsExample -
- Paste Chri+ | In-Place Editar

‘&q Deployment Descript| ==

228 Java Resources: sre Delete Delete Default Editar
B e Build Path 4
1 erv.navig Refactar Ale+Shife+T ¥
=2 Librari
B, Libraries pug Import...

B, Apache Tome -
B\, EAR Libraries 13 Export...

B JRE Swstem L &) Refresh F5
=i web App Libi
(= build Yalidate
= TelosysTools Run &s 3
== WebContent Debug As 3
(= META-INF Profile As 3
(= screen Team »
(= telosys Compare With »
(= template Replace With 4
= test SOurceE k
= [= WEB-INF
== canf Properties Alk+Enter
=

databases.dbc
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If the “database.dbcfg” has been correctly modified
the derby database appears in the combo-box.

g
=

=1 databases.dbcfg X

Database

0 - DEREY - TelosysB

Id:

Marme :

Ditiver &

LRL :

Pool size :

User

Password :

Configuration | Informations | Meta-data |

Isolation level :

=40
A
[ Generate repositary ] |Jpdate repositary
| o | [ Tesk connection
| DEREY - TelosvsBookstore DE |
| org.apache.derby . jdbc. ClientDriver |
| jdbciderbys flocalhost: 1527 Ibockstore |
| |
E |
| roak | —
| admin |
w

Database ]

Select the “Derby Bookstore” database

Click the «Test connection» button to test connection to database ...

& Information x|

i ) Connection is OK.
Connection's current catalog = 'null’
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4.3 — Generate the repository

Once the connection has been verified, just chek¢Generate repository» button to launch
the generation of a new repository.

x

\‘g/'- This operation wil replace the current version of the repository if it exists.

Repository file :
TelosysTools/repos/DERBY - TelosysBookStore DB.dbrep

Database name :
DERBY - TelosysBookStore DB

Launch the generation ?

oK | Cancel
Click the "OK” button.
x|

\!J) Repository generated.

See file TelosysTools/repos/DERBY - TelosysBookStore DB.dbrep

The repository file (dbrep ) is generated in th&®losysTools/reposdirectory
(as defined in the project’s properties)

== TelosysTools
= lib
== repos
[‘ﬂ] DERBY - TelasysBookSkare DB, dbrep
D info. bk

In case of changes in the database tables, amexispository can be updated with the
“Update repository’ button.
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Double-click on the repository file ( .dbrep ) tpem it and to view/edit the database entities

The repository editor looks like this :

&l DEREY - Tel

Database "DERBY - TelosysBookStore DB" ( Apache Derby )

Database table

e DB dbrep X

|auTHOR ]

Mapping and standard classes | Specific |

Java classes

Database Mame Database Type JDBC Type Jawa Mame Jawva Type
S ID ¥ INTEGER 4 integer id int Value Object Bean { ¥0 )
FIRST_NAME WARCHAR(40) 12 : varchar firstMame Skring
LAST_MAME WARCHAR(40) 12 : varchar Jasthame String | Author |

Eean list { YO List )
| futharList |

Eean D4,
| AutharDAo |

Bean converker (XML}
| Authargml |

l “Y\
N Editable
fields

Generate ]

|~
|

Mapping | Bulk generation | Config

You can modify :
* each attribute Java name and Java type
* the Java classes names to be generated
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Step 5 — Code generation

5.1 — Generate basic Java classes from the reposito

For each table/entity you can generate
* a‘“Bean’ (simple “Value Object” / “POJO”)
* a‘“Bean List’ ( ordered and sortable list of Beans )

ry

* a‘“Bean DAO’ ( Data Access Object ) to manage the databasespemce

* a‘“Bean convertet to manage the XML conversion

Example for “Book” entity :

XML

Telosys Starter Kit - v 1.1.0 ( September 2010)
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- Generate Java classes for one entity :

Select the entity in the combo-box
Select the Java classes to generate
Click the «Generate» button.

The Java files are generated in the packages ddfin@e project properties.
Select the Config” tab (at the bottom of the window) to see the entrconfiguration

- Generate Java classes for all the entities :

Select the 8ulk generation » tab (at the bottom of the window) :

_-ﬁ DEREY - TelosysBookStore DE.dbrep X

Database "DERBY - TelosysBookStore DB" ( Apache Derby )
Table Name Java Bean Standard t.?rgets
AUTHOR author Yalue Ohject Bean { YO )
BOOK ook [¥]Eean list { WO Lisk )
ECOK_ORDER BookOrder [#]Bean D.4.0.
BOOK_ORDER_ITEM BookCrderItem [ Bean canverter (ML)
COUNTRY Courtry
CUSTOMER Cushomer specific bargets
EMPLOYEE Employes
PUBLISHER Publisher
REWIEWY Review
SHOP shop
SYMOPSIS Synopsis
< >

Select Al l [ Deselect Al
l Select Al ] [ Deselect Al
l Launch bulk generation ]

Select all the Table/Java Bean : Click th&etect All » buttons
Select all the “Standard targets”

Click the «Launch bulk generation » button

- 4 Java classes are generated for each entity.

The “Data Access Layer” of the project is now resmlyse for all the entities of the database.
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5.2 — Test the “Data Access Layer” with the databas e

Ensure the database is running.

Run the web project :
Right click on the projec® Run As—> Run on server

By default

each DAO can be called in REST mode &idJRL) :

How to call a DAO in REST mode (request examples)

dao/Author loadlist

dao/Author loadlist 7 where=id < 5

dao/Authorload?id=1

Select one of the links to see the result

= (O |http:fﬂocalhost:SDSthestllﬂbjdaojEmployeejload\ist

<?xml version="1.0" encoding="UTF-8" ?>
- <response dao="org.demo.vo.dao.EmployeeDAO" action="loadlist">
<return code="11" />

- <data>

- <dao-result>

<item code="A001" shopCode="AAA" firstName="JEAN" lastName="DUPONT" manager="1" />
<item code="A002" shopCode="AAA" firstName="PAUL" lastName="DUBOIS" manager="0" />
<item code="B001" shopCode="BBB" firstName="JACQUES" lastName="DUCHEMIN" manager="0" />
<item code="B002" shopCode="BBB" firstName="ALINE" lastName="DUFOUR" manager="1" />
<item code="B003" shopCode="BBB" firstName="MARC" lastName="DUFENOUIX" manager="0" />
<item code="C001" shopCode="CCC" firstName="MARCEL" lastName="JOSIAN" manager="1" />
<item code="C002" shopCode="CCC" firstName="KEVIN" lastName="TOTTO Ma modif' manager="0" />
<item code="D001" shopCode="DDD" firstName="PATRICK" lastName="CHIVON" manager="0" />
<item code="D002" shopCode="DDD" firstName="ALBAN" lastName="VANIER" manager="1" />
<item code="F001" shopCode="FFF" firstName="BERNARD" lastName="TALMONT" manager="1" />
<item code="G001" shopCode="GGG" firstName="THOMAS" lastName="VIRSOT" manager="1" />
</dao-result>
</data>
</response>
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5.3 — Generate specific files from the repository

The Telosys Tools plugin is designed to be extenuhedrder to generate specific files
according with the specific needs of a project.

The generation is based on Velocity templates (files ), located in the
“TelosysTools/templates” folder.

How to add a new generation target ?
1. write the new Velocity template ( .vm file )
2. additin the “TelosysTools/templates” folder
3. reference it in the “TelosysTools/templates/tengdatfg”

When you re-open the repository editor, the spetafigets appears in the “Bulk generation”
view.

'@l DERBY - TelosysBookStore DB.dbrep 23 _@ http:/flocalhost:8080/test1 10b/dao/Employeefioadist | [ templates.cfg |
Database "DERBY - TelosysBookStore DB" ( Apache Derby )

Table Name | 3ava Bean | | Standard targets
AUTHOR Author IV Value Object Bean (VO )
[] BoOK Book [v Bean list { VO List )
BOOK_ORDER BookOrder ¥ Bean D.A.O.
BOOK_ORDER_ITEM BookOrderltem 5 Boan convester gahi)
COUNTRY Country \
CUSTOMER Customer - Spedific fargets
EMPLOYEE Employee ] HTML documentation
MASTER Master [] screen Data dass
ORDERS Orders [ screen Manager ciass
PUBLISHER Publisher [ screen Map (3SF)
REVIEW Review [ screen Behavior(Java...
SHOP Shop [ screen Search Proc d...
SLAVE Slave [ screen Search rendere...
SYNOPSIS Synopsis
\
SeectAl | DeselectAl | Select Al Deselect Al |

Launch bulk generation |

Mapping | Bulk generation | Config |

The Telosys starter-kit comes with a set of spet#rgets allowing “scaffolding” for basic
CRUDS (Create/Retrieve/Update/Delete/Search) ssreen

The screenshot above shows these specific targets.
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The specific targets by cateqgory :

Client-side components :
» ScreenMap view ( .jsp)
» ScreenMap behavior ( .js)

Server-side components :
» ScreenData class ( .java)
» ScreenManager class ( .java)
» ScreenProcedur class ( .java)

Rendering components :
» Search result renderer ( .jsp)

Documentation :
* HTML page describing the entity ( .html )

Test the specific targets with the “Employee” antit

-> generate all the specific targets for the “Emp&dyentity
- run the project

-> call the “Employee” screen by the URL :
http://localhost:8080/test110b/screenmap/Employee

DERBY - TelosysBookStore DB.dbrep M templates.cfg ]
- o | http://localhost:8080/test110b/screenmap/Employee

Employee

code : [
shopCode : |—
firstName : [
lastName : [
manager : [

Open context Get from context DB : Load DB : Insert

Close context Set in context DB : Save DB : Update

Clear screen Clear context DB : Delete Exec Search

Finally, you can generate all the targets forltadl éntities.

Now let’s have a look at the generated components,
it's a good way to discover basic use cases ofrttmeework...
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